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INTRODUCTION

Dear Customer,

You have made a good choice by purchasing a MK3 Microdot Marking System. Thank
you for your trust in our product. Your system will honour this trust, but there will be one
condition to satisfy right from the onset: The system should always be treated with
respect, even under the most ardent of conditions. Therefore, these Operating Instructions
should be kept with operators.

It would be a mistake to have these Operating Instructions rot away under heaps of dust.
We have therefore endeavoured to give you all the recommendations and information
necessary for operating, servicing and monitoring your system.

Please read these Instructions carefully PRIOR TO COMMISSIONING the system in order
to become familiar with them.

Following these Instructions precisely will save you time and prevent losses, and you will
still be fully satisfied with the system’s performance in years to come.

This manual is not allowed to be copied.

We wish you success in your work and optimal results by employing your SCHILLING
System.

Thank you for your attention and have a good start!
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IMPORTANT SAFETY INSTRUCTIONS

1. Read the instruction for installing the equipment.

2. The equipment must be power connected with a three-wire grounding type power cable
terminated with a plug having a third (grounding) pin. This plug will fit only into a grounding-type
power outlet.

3. In addition, the device is equipped with grounding marked bolts that mast be connected to earth
as near as possible.

4. Do not allow anything to rest on the power cord. Locate the device and the power and ground
connections in such a way that persons will not walk on the wires.

5. Do not attempt to service the device yourself. Opening or removing the covers may expose you
to dangerous voltage points or other risks. Refer to service personnel.

6. Unplug the equipment from the wall outlet and refer servicing to qualified personnel under the
following condition:

. when the power cord or plug is damaged or frayed,;

. if liquid has been spilled into the device;

. if the equipment has been exposed to rain or water;

o if the equipment does not operate normally when the operating instructions are followed.
Adjust only those controls that are covered by the operating instructions, since improper
adjustment of other controls may result in damage and will often require extensive work by a
qualified technician to restore this product to normal operation;

. if the equipment has been dropped or damaged;

. if the equipment exhibits a distinct change in performance, indicating a need for service.
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1. INTRODUCTION

1.1 High performance marking equipment

The Stamper forms an Open System, being possible to interface it with an IBM compatible
Personal Computer running under Windows operating system, using standard Schillmarker
software on sale, provided it is HP-GL compatible.

The equipment is composed of:

Mechanic Marking Unit (with 1 standard stylus)
Electronic Control Unit
Pneumatic Group consisting of:

- Pressure Regulator
- Pressure Gauge
- Air Filter

CD-Rom with installation program
Set of cables
Optional accessories

The Control Unit is composed of three boards: Logic Control board, Power Driver board, Power
Supply board. All these boards are mounted in a metallic box with a front panel. On the front
panel a set of operating visualization LEDs and connectors are available.

Mechanic Marking Unit is composed of: sturdy mechanic structure, high precision axis
movement and marking stylus assembly giving special features for the installation and
operation:

- Fixing by only four screws

- Anti-dust sliding shutter

- Quick stylus change

- Optional stylus for specific jobs

Pneumatic Group is composed of: quick coupling to air tube, pressure regulator 0-6 bar,
pressure gauge 0-10 bar, high frequency and long-life electro-valve (2.000.000.000 operations)
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1.2

1.3

14

PC configuration

The minimum requirements for the equipment operation are:

CPU 486

MS-DOS + Windows 3.1
RAM 2 Mb

1 CD or DVD +/- RW Drive
1 Hard disc 40 Mb

Monitor VGA

1 Serial port for the Stamper
1 Serial port for Mouse

1 Mouse

Operation principle
The Marking Unit is managed by the Control Unit that interfaces with the PC via a standard
serial interface RS232C in HP-GL 7585B language.

The PC can run under Schillmarker software for Windows to provide the diagram or the
numbering scheme to be output.

The Control Unit provides the proper conversion of the commands sent from the PC into
electrical signals for driving the mechanism of the Marking Unit.

Marking is achieved by means of a stylus using the "Microdot" system with pneumatic action.

Stylus movement takes place by means of two axis with two step by step motors with high
angular precision controlled by a 16 bit microprocessor with chopper motor driver.

Full Agreements to European Safety Rules

The various parts that form the equipment has been planned to satisfy the safety rules, and in
detail:

e The Mechanic Unit fulfills IP54 safety specifications and can be easily integrated into a
system provided with protection device and interlock mechanism for the stylus working area
invasion.

e The Electronic Unit fulfills the European electrical safety rules.

‘
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2. UNPACKING AND INSTALLATION

GENERAL WARNINGS

This Manual has the goal of giving instructions for:

- the accurate installation,
- the safe and efficient operation of the apparatus
- the continual and regular maintenance.

The appliance must be used according to the procedures contained in this Manual and it must
never be used for purposes different from the one scheduled.

The user is responsible for what concern the fulfillment in the legal subject concerning
installation and operation of the equipment.

If the equipment is not operated in correct way or a not appropriate maintenance is carried out,
the manufacturer cannot be considered responsible for any possible breakage, damage and
malfunctions.

2.1 Unpacking

The appliance is supplied in a wooden case with dimensions and weight as shown in the
picture.

max gross weight = 33kg max gross weight = 45kg
f s c

VERSION 80x50 100x80 VERSION 200x200

Open the packing, and check that:

- the supply corresponds to order specifications (see the delivery note);
- there are no evident damages.

In case of damages or of missing parts, please inform immediately and in detail the forwarder,
Schilling or its area Agent.

All the dimensions indicated in this Manual are not binding and are related to the standard
machine.

The drawings and any other document delivered with the machine are property of Schilling
which reserves all the rights, and they cannot be placed at a third party disposal.
The reproduction of the text or of the plates, even patrtial, is forbidden.
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2.2 Contents of packing

1 Mechanic Marking Unit

2 Electronic Control Unit

3  Standard stylus

4 Marking-Control Unit cable

5  Protection cover for cable

6  Power supply socket

7  Pneumatic Group

8 Airtube

9  Application program floppy disk

10 Hardware key

11 DS 1425 module for software options

12 Operation Manual

13 Set of installation screws

¥4y
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2.3 Options

Different options are available on request.

1 Base plate
2 Column frame
3  Different stylus types:

@3 mm HRC92 with 60°, 90° & 118° tip
@6 mm HRC92 with 60°, 90° & 118° tip

4  Remote I/O with pressure regulator

Standard remote 1/O

QFICq
A

www.schilling-marking.de &P 2
info@schilling-marking.de ’2@ N

/soqQQ

—5 Schilling Marking Systems GmbH s 0 IO ) %
[ =1 1 Grubenacker 1 DE.7853 Tutingen +49 (0)7461 94720 [ +49 (0)7461 947220 X



MK3 - User’s Manual 11
E J@Dﬁﬂﬂﬁ Unpacking and installation

Marking Systems GmbH

2.4 Positioning

The equipment has been tested and checked in the factory; no other setting before the
installation is required.

Unpack the appliance and find an installation place according to the following directions:

1. The Control Unit must be placed in vertical position leaving a free space of about 10 cm. to
guarantee a correct ventilation.

2. Do not place the Control Unit near any sink etc. in order to avoid any contact with water
and consequently the short-circuit on the electrical circuits.

Do not install the Control Unit in places with an insufficient ventilation.
Do not place the Control Unit near any heat source.

Do not install the Control unit on vibrating plate. If necessary use proper isolators.

o ok~ w

Install the equipment so that the power supply cable will not be bent but can run freely to
the a.c. outlet.

7. Fix the Marking Unit on a suitable support by means of two mounting holes. This Unit may
be oriented to any direction.

8. Pneumatic Group (pressure regulator, pressure gauge, air filter) must be mounted near the
Marking Unit (max 2 m away).

9. Be sure that the Control Unit is not mounted on parts subject to vibrations. In this case the
use of vibration-damping devices is suggested.

10. To assemble the unit, see illustrations on next pages.

‘
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176 . ‘ 145
“l
6 holes M6
not visible
22
246
50 \_£M6
50
21 o J B
Side view
Front view A
10
43 80
l Needle Assembly Number
a7 66.62032.35|66.62132.3S| 66.62150.6S
50
A[mm]| 825 82,5 97,5
Top view

Dimensions and holes for Marking Unit 80x50 installation
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262 237
65 125
53
188,5
55
A
91 5 holes M8
55 not visible
Front view Side view
A
10
88
100
Needle Assembly Number
86,5 66.62032.3S5(66.62132.3S| 66.62150.6S

80

A [mm] 82,5 82,5 97,5

MARKING AREA

Top view

Dimensions and holes for Marking Unit 100x80 installation
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Dimensions and holes for Marking Unit 200x200 installation
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259 356
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8 holes M8 55
55148 not visible
Rear view Side view
A 10
875 200 Needle Assembly Number
89 66.62032.3S(66.62132.3S| 66.62150.6S
A [mm] 82,5 82,5 97,5
MARKING AREA
Top view
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Rear view Side view
Dimensions and holes for Control Unit installation
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2.5 Connections

WARNING

The appliance is in compliance with the electrical safety requirements foreseen by the
normative Institutes.

As the electrical safety of this appliance is assured only when it is correctly connected to an
efficient grounding system (as foreseen by the law), it is important to verify that this main safety
requirement is properly provided.

Check that the power rating of the electrical system and of the a.c. sockets are adequate to the
total power of the appliance indicated on the rear plate.

In case of doubt ask for a technical check.

The manufacturer is relieved from any responsibility for possible damages caused to people or
things deriving from the non-observance of what stated above.

The manufacturer is relieved from any responsibility for possible damages caused to people or
things deriving from the lacking of the ground connection.

VERY IMPORTANT NOTICE
To avoid damages on the Electronic Controller it is always necessary to make connection
between Marking Head and Electronic Controller (see par. 2.5.3) before the machine is
powered on (see par. 2.5.2).

Never disconnect the Marking Head from the Controller when the machine is ON.

As suggestion, activate pneumatic connection only after having done electrical connections and
having ascertained correct positioning of the component to be marked.

‘
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2.5.1 Ground connection

Connect the ground bolt of both the Control Unit and Marking Unit to a ground point, using a
cord of suitable section (not less than 10mm?2) and headed with a plug.

2.5.2 Power connection

S EEEEITEITy

(5]

335 & S0

%a

%

e
o
)

Ry,

|~

—]
230 n
—

Using the supplied power socket connect the power cable and the plug; verify the setting on the
switch as indicated on the figure. Adjust using a screwdriver as required by the available a.c.

voltage.

Warning: The Controller is provided with power switch that feeds the power voltages to the
complete equipment.
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2.5.3 Interfaces connection

To I/O Aux To remote
1/10

Connect the Marking Unit and Control Unit by means of supplied cable. Then fix the protection
cover of the connector on the Marking Unit by means of two screws.

Proceed for the other connections as reported on the following pages.
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2.5.4 1/0 Connection

Connect the Remote 1/0 or PLC (if used) to the 1/0O connector on the Control Unit.
The connector is 9 pin/male type and the configuration of the pin is as follows:

Controller 1/0
connector Description
Signal Comment
Pin 1 +24Vaux common return wire for the READY and END
signals
Pin 2 Marking STOP input of a clear contact (normally open)
Pin 3 PWM+ out for a remoted fine pressure regulator
Pin 4 READY out machine signal
Pin 5 Ground common return of the clear contacts
Pin 6 Marking START input of a clear contact (normally open)
Pin7 Low pressure input of a clear contact (normally open)
Pin 8 PWM- Out for a remoted fine pressure regulator
Pin 9 Marking END out machine signal (0 V during the marking)

Ready \T ’—‘

Start ‘ ‘ ‘

| |

End

Machine status representation
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Suggested test

To make sure that the Marking Unit has not been damaged during transport, it is necessary to
test the equipment after have made the electrical connections using the cables supplied:

- marking head and Control Unit
- remote I/O and Control Unit
- power cord on the Control Unit.

1. Mount the stylus and verify that no plates are in the marking area.

2. Plug the power cord on a socket to power on the equipment.

3. Push on the START button of the remote 1/O. Being the Marking Unit equipped with back-up
battery that keep the last factory test data, the needle should move according to this stored

cycle.

This proves the electromechanical functionality of the system. During this cycle, it is important
to make sure that marking area is free from any obstacle against which the needle could bump.

Proceed with the connection between the Personal Computer and the RS232 socket in the

Control Unit using a serial cable.

AUX connection

This interface provides 8 inputs and 8 outputs that can be used to interface an optional
motorized column or various auxulliary devices (as example partcount, external signalling etc.).
The signals of the interface are reported on the following figure:

8 INPUT

)

GNDAUX

8 OUT<

+24VAUX

el To oo o To oo ToToTo T

1

L +24AUX
: +24AUX
+24AUX
—;LL +24AUX
INPUTL
ﬁ"ﬁ— INPUT2
1 INPUT3
L INPUT4
INPUTS
—18 — |NPUTE
Agi— INPUT?
INPUT8
7
| 20
ouT1

GNDAUX
GNDAUX

GNDAUX

‘

Schilling Marking Systems GmbH = ] I
In Grubenécker 1 DE-78532 Tuttlingen +49 (0)74619472:0 =

+49 (0)7461 9472-20 %

www.schilling-marking.de
info@schilling-marking.de

QFICq
SE<4

io)
A, 150 QQQ

& P
* EKRA
o

Z
*



MK3 - User’s Manual 21
E J@Dﬁﬂﬂﬁ Unpacking and installation

Marking Systems GmbH

Serial cable Controller-PC
Connect the serial port COM1 or COM2 of the PC to the RS232 connector of the Control Unit
with a cable of 15 m max. On the Control Unit the connector is 9 pins/female type.
If the COM1/2 of the PC is equipped with a 9 pin connector, make the connections in the figure.

If the COM1/2 of the PC is equipped with 25 pin connector, use an adapeter 25 pin/9 pin or end
the PC side cable on 25 pin connector making the connections in the figure.

Controller
10
) 6O RXD TXD
3 70— / \ TXD RXD
8O 1
40
) GND
9 pin male 9 pin female
Controller PC
1© 6 O RXD %“
oot [ ™o [ s ©
s Ol o
;Og @] k ) GND k ) [245 ©]
_ _ LB o
! o © ;
9 pin male R zog
S ©
o O
o O
25 pin female
Warning The cable screen must be soldered to only one of the two connectors (side PC

or Controller)
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2.5.5 Pneumatic connection

Warning The pneumatic joint on the Marking unit is protected by a plug to avoid any solid
residues from entering into the pneumatic circuit that could compromise the

Marking operation. Remove the plug only when the pneumatic connection has to
be carried out.

Connect the air source to the input of Pneumatic Group; the air pressure must be not more than
6 bar.

Connect the Pneumatic Group output to the Marking Unit by means of the supplied tube.

To remove the tube, lower the ring of the adapter with the fingers
and pull out the tube.
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2.5.6 Stylus mounting

The stylus is mounted on the threaded joint under the Marking Unit.
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2.6 Switching on the system

2.6.1 General
Before to switch on the system, verify that:

1. all the connections should be carried out correctly,
2. ground bolts on the Controller and Marking head should be ground connected,

3. the 230/115 V arrangement on the Controller should be set according to the voltage
available,

4. the stylus should be correctly mounted,

5. the pneumatic circuit should be operating and the manometer read a pressure value not
more of 6 Bar.

Switch on the equipment by mean the power switch on the Controller. The system will be
automatically powered and the stylus moved on the rest position (left up of the working area).

Now use the application program to carry out the marking cycles.

2.6.2 Switching on with default data loading and job reset

When firmware upgrade must be performed, it is necessary to load the default data into the
controller memory with the following procedure:

- switch off the equipment,

- pushing on both the START and STOP buttons of the remote 1/0O switch on the Controller;
wait for about 3 seconds before to release the buttons.

With this operation the default data and the job reset will be perfoprmed.

M To perform only the job reset operation, switch on the equipment pushing on the
STOP button of the remote 1/O device for 5 seconds.
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3. USING THE APPLICATION

3.1 Introduction

Before beginning Marking
1. Mechanic
During positioning of the part in marking position verify that there is no possibility of

collision of the stylus during operation.

Adjust the distance between stylus and part, according to the hardness of the material to
be marked; for soft materials part has to be located as near as possible to the stylus.

Do not use high pressures when keeping the marking angle lower than 75 degrees vs.
the marking surface.

For high pressure marking, control that the part is tightly fastened.

Before a new marking operation, make sure that the stylus holder is correctly fastened.
Periodical dry cleaning must be done to the punching stylus.

Never lubricate any part of the stylus.

Never lubricate the axis.

Resharpen the stylus when it is blunt.

2. Electric
Connectors must be handled with care.
Verify that voltage is the correct one.
Verify that earth connections are correct.

Verify that connectors are correctly fitted both to the Control Unit and the Marking Unit.

3. Pneumatic
Be sure that air is dry.
Do not misuse air tubes.

Periodical dry cleaning must be done to air filter.

When you are planning the marking work, remember that the marking area may be 80x50,
100x80 mm or 200x200 mm as indicated in figure. The X/Y coordinates of the marking
start that may be programmed on the menu are referred to the electric zero point (lower).
On the contrary the mechanic rest stylus position is upper.
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42
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zero position

Marking area

VERSION 80x50
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VERSION 100x80
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VERSION 200x200
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The scope of the present wINDOWS ™ "SchillMarker” Software substantially consists of the
following output features:

e Allowing fast generation, processing and saving of rating plates
e Controlling the MK3 Impact Marker for marking outputs through a serial interface

In addition to functionality, which is a natural characteristic, features such as user-friendliness, i.e.
simple, fast operation and short learning ramps were considered in the design of the software.
This will be described in the following by means of a small introductory example.
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3.2 Introductory Sample

1.) Enable the SchillMarker by clicking twice on the icon in the programme manager in order to
display the main window of the application:

e User: b39% GDE 679 Schilling Marking Systems - SchillMarker 3.12
File Edit View Plsiz  Options

W 2 T|sEEE
5
]
o ] o

| [ %51, 67 | [NUM |
Fig. 1: Main window including marking area and a new rating plate.

The centre shows a frame, symbolising the area in which the marking device can be moved, the so-
called marking window.

2.) Select "File” from the menu by using the "New plate” command.

P4l View Plate  Options

Open... EFD ‘\ @I@I ﬁ

P
Configure printer

Transmi
§‘§M% ;fﬁé;fkéfsg

?xi% b pmavking

Exit

Fig. 2: Menu file - New plate
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This is followed by an interactive window for entering the rating plate dimensions:

Left - Top wid(:- Height

= [pmn Width W
¥ |u.uu Height IEI].I]I]

/ oK I x.ﬁ.hl:-ruch

Fig. 3: Plate prompts - Inserting and positioning a plate

It will be all right to acknowledge the introductory example by "OK” in order to generate a standard
rating plate.

3.) Generate a new text box on the rating plate by selecting the "New text box” command from the
"Plate” menu:

bl User: 69% GDL 67% Schilling Marking Systems - SchillMarkd
File P+ View Options

..... g Plate position and height }2:3:

Mew counting box
Mew date box
Mew graphics box

Position new text box
Position new counting box
Position new date box

Fig. 4: The plate menu - New text box
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The following will be displayed:

i User: 69% GDI: 672 Schilling Marking Systems - SchillMarker 3.12
File %4t Yiew Plate Options

Hl | e 88 ==ER W
New box [ .
]
& m R
[ [(w3szv 32 | MM [

Fig. 5: New generated rating plate including a text box

You have now generated a complete rating plate ready for marking.

4.) Then select the "Automark” command from the "File” menu.

i User: 69% GDI: 6726 Schilling Marki
4t ¥Yiew Plate Options
MNew Plate . [
Open... EH:' n
Save =
Save as... PR Tl

Print
Configure printer

Transmit
Start marking
Update

| Exit |

Fig. 6: The Automark file menu

The mouse cursor will be displayed as an egg timer during data transmission. When returning to an
arrow shape, one full cycle has been completed for generating and marking a rating plate by using the
SchillMarker software.

Now only press the green start button on the marking device to mark the generated rating plate.

So much for starters. As you will guess, SchillMarker software allows you to do much more than this.
However, this will be explained in the following detailed documentation.
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4. BASIC INSTRUCTIONS FOR OPERATION OF THE PROGRAMME

In order to understand the SchillMarker software better and use it more efficiently, here is some initial
basic information for operation of the programme.

4.1 Data Units

The following data units will be supported (at present):

4.1.1 The Marking Window

The marking window is displayed on screen as a 3-dimensional frame, representing the output range
of the Impact Marker and therefore not being adjustable in size. Only the contents of the impact
marking window can be output (marked).

4.1.2 The Plate

The marking window contains a maximum of one plate which is displayed as a 3 dimensional raised
area. This may be of any size and positioned at any point.

4.1.3 The Boxes

The following box types will be supported:

Text box
Date box
Counter box
Graphics box

Like the plate, the boxes may be any size to be located in any position (although it would not be very
sensible to position boxes outside the plate). Boxes which are to be output are shown as 3-
dimensional recessed areas. For boxes not to be output, only the box contents, but not the box frame
will be displayed, allowing you to display on screen pre-designed rating plates which are very close to
reality.

All boxes are in principle "part of” the plate, i.e. if a plate is displaced, all boxes will be displaced, thus
remaining at the same point on the plate.

Therefore there is no box without having a plate.

Hint: The fact that all boxes belong to a plate is of great advantage. When doing the first trial
marking, you may find that the clamping position was not exactly aligned after marking a plate.
In this case, the full plate is simply displaced by the error, not requiring repositioning of each
individual box - as in many other programmes.
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4.2 Dimensions

All figures, such as rating plate dimensions or font sizes processed in the programme must be stated
in millimetres (mm), i.e. when an existing rating plate (sample) is to be generated by the SchillMarker
software, all dimensions may be taken from the sample by means of a ruler or calliper gauge.

4.3 Positions

All positional data (again in (mm)) refer to the left-hand top corner of the plate, with the exception of
the plate position itself, which refers to the left-hand top corner of the marking area.

4.4 Screen Displays

As described, all dimensions are saved internally by the software in mm. Therefore these dimensions
must be converted for the screen display into screen and/or so-called pixel co-ordinates.

The SchillMarker software operates similar to a CAD (Computer Aided Design) system, i.e. allowing
to view the geometry, or in this case rating plates including their boxes and text contents - in any
enlarged or reduced scale and in random screen positions.

So-called True Type fonts, made available by WINDOWS ™ are used for screen output of text, with
the image of text on the screen not always being identical with the marked font type. This is due to the
fact that the Impact Marker is not a True Type compatible output device but has its own fonts.

This minor flaw, however, refers exclusively to the image of the font, not to its position and size, i.e.
individual letters and numbers will be displayed during marking in exactly the same point and exactly
the same size as displayed on screen. Furthermore, this ensures that whatever fits into a box on
screen will be identical as an impact marking (WYSIWYG = What You See Is What You Get).

4.5 Online-Help

The Schillmarker software has a online-help function. This online-help represents a kind of
electronical users manual.

You select the online-help with the ,Help“menu command. Following help themes will be displayed:

e Contents

e Survey

Basic Elements
Introductory Example
Display

Manual

e How to use help

¢ Info about ...

Dialogues that need to be explained have their own help-buttons. After you have pressed such a help
button, a corresponding text is displayed.
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5. DETAILED OPERATING INSTRUCTIONS

The following detailed operating instructions will make you familiar with the functions of the
SchillMarker software. In order to understand this, you should have "played” with the introductory
example to start with.

5.1 Hardware requirements

You will require an IBM-compatible PC of the following recommended minimum configuration:

Processor: 80486

RAM: 8 MB

Available hard disk 10 MB

VGA graphics card 640 x 480 pixels, 16 colours

2 serial interfaces (important!) (one for the mouse and one for data communication

to the Impact Marker)

5.2 Software installation

Insert disk No. 1 and start SETUP.EXE programme.

5.3 Adjustment for the used serial interface

Turn off the FIFO-Buffer. (Windows-Manual)

5.4 Starting the SchillMarker software

The actual programme is accessed by starting the SCHILING.EXE file. The following files are required
for correct execution of the programme:

CTL3DV2.DLL
BWCC.DLL
BWCCO007.DLL

These will be copied during installation to your Windows system directory.
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5.5 Generating a new plate

Select the "New plate” command from the "File” menu.

An interactive window will be displayed for entering the rating plate position and dimensions:

Left - Top Width - Height

* omm | Width [70.00
¥ |u.uu Height IEI].I]I]

/ oK I x.ﬁ.hl:-ruch

Fig. 7: Plate prompts - Inserting and positioning a plate

5.6 Changing the position and size of a plate

After having generated a plate, the position and size of the plate may be changed at any time within a
marking window.
This can be done retrospectively after some boxes have been generated and positioned on a plate.

Select the "Position and size” command from the "Plate” menu item
or:

double click on the left-hand mouse key inside the plate which is raised in order to show any
previously displayed "Plate” prompts.

5.7 Generating new boxes

5.7.1 Generating standard boxes

As previously explained, there are several types of boxes. Their generation, however, is only
marginally different and therefore can be treated jointly. The most simple way of generating new
boxes consists of generating so-called standard boxes. Standard boxes have a preset position, size
and contents. These allow fast and simple generation of new boxes and to adapt these by convenient
processing functions to your own requirements.
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Select one of the following commands from the "Plate” menu item:
"New text box”
"New counter box”
"New date box”

An appropriate standard box will be displayed.

5.7.2 Generating graphics boxes

Generation of graphics boxes is in panapIe based on reading a file in HPGL format (HEWLETT
PACKARD GRAPHICS LANGUAGE ). Files of this type often have a *PLT extension which means
that they are a plot file. Therefore when selectlng the edit command:

"New graphics box”
a suitable "Open file” prompt will be displayed.
After selecting a file, the HPGL Interpreter (= filter) will generate a graphics box from the file, with

HPGL data being sensibly converted, i.e. a graphics box having a height or width of maximum of 50
mm and being displayed in the left-hand top corner of the marking window.

5.7.3 Generating boxes in specific positions

Select one of the following commands from the "Plate” menu item:
"Position new text box”
"Position new counter box”
"Position new date box”
The mouse cursor will change to a graticule.
Position the graticule to the point to which the left-hand top corner of the new box is to be moved.
Then press the left-hand mouse key and hold it!
When moving the mouse, a frame will be displayed, showing the size of the box. When letting go of

the left-hand mouse key, a new box of a suitable size will be displayed in the respective position. Do
have a try!

5.8 Changing the position and size of individual boxes

5.8.1 Marking a box

After having generated boxes which are to be changed, you must initially tell the systems which boxes
are to be changed. Mark the box.

In order to mark a box, click twice on the box with the left-hand mouse key.
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A so-called "focus framr " will be displayed around the box, which will be familiar to you from
"standard” WINDOWS " windows.

5.8.2 Graphics changes in box position and size

The position of a box may be changed by clicking on the box with the left-hand mouse key and
keeping the mouse key pressed. The mouse cursor will change to a four-way arrow. When moving the
mouse - whilst the left-hand mouse key is pressed - the box may be placed at any point. When letting
go of the mouse key, the new box is set to its new position.

By the way: The method described above, i.e. moving the mouse whilst the mouse key is pressed, is
often referred to as "dragging ”. You will certainly come across this term again.

The size of the box, too, is changed in a similar way:

The size of a box may be changed by clicking on the focus frame with the left-hand mouse key and
keeping the mouse key pressed. The mouse cursor will change its shape - depending on what area
you clicked on - becoming a two-way arrow, showing the directions into which the edge of the box can
be displaced. When moving the mouse - whilst the left-hand mouse key is still pressed - the box may
be enlarged and reduced at random. When letting go of the mouse key, the box will be displaced in its
new size.

For graphics boxes, the size of the box is automatically converted to the size of the graphics image,
i.e. when changing the size of a graphics box, the size of the graphics image will change, too.

5.8.3 Accurate setting and/or finding a box position and size

In order to accurately set and/or find a box position and size, the relevant "Box” prompt window must
be opened. There are two options to do this:

You may:

1. "Double-click” on the box. Double clicking means clicking on the left-hand mouse key twice in
very quick succession

or:

2. to initially mark the box by clicking the mouse once, followed by ENTER.
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The "Box” prompt will be displayed as follows:

= Box
Content
| S |
Left - Top Kind of box Dizplay Dptions
Left IT “* Text “* Standard | editable
T » Counting  Bound get | | plot
0 I
R 1-00  Date  Angle _ | Background
Width - Height iaxy
Width |3I].I]l] Alignment
Height |5_l]l]
/ oK xﬁ.bbruch

Fig. 8: Box prompts - Position, size, box type and other settings

The top sections will display the actual position and size of a box. In order to change one of the

settings, tell the (unintelligent) computer which. There are three options (as in all Windows

applications):

You will obtain the setting to be changed

¢ by clicking on it with the mouse

¢ by selecting it with the tab key

e by selecting it with a so-called hot-key, i.e. by pressing the underlined letter of the box code whilst
the ALT key is pressed. Example: ALT + B for box width or ALT + H for box height.

In each of the cases described, the appropriate box is selected, allowing you to make your entries.

5.9 Aligning of several boxes

5.9.1 Marking of several boxes

After having generated several boxes, which are to be aligned to each other afterwards, you must tell
the system which boxes are to be aligned, i.e. by selecting several boxes.
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There are two options for selecting several boxes:

e You may select several boxes by clicking once with the left-hand mouse key on each of the boxes
to be selected whilst the SHIFT key is held down. This will generate a focus frame around all
selected boxes. Furthermore, this method allows to deselect selected boxes. Simply click another
time on a previously selected box whilst the SHIFT key is pressed.

e Your may select several boxes by placing a focus frame around all boxes to be selected. Click in
the area of the plate which has no box (when clicking in a box, you would select it!). Then move
the mouse (keep the left-hand mouse key pressed!) until the focus frame fully surrounds all boxes
to be selected. When letting go of the left-hand mouse key now, a focus frame will be generated
around all selected boxes.

5.9.2 Aligning of several boxes end to end

After having selected several boxes, as described in the last section, the following commands will be
activated in the "Process” menu:

Align left
Align right
Align top
Align bottom

o User: 69% GDE 67% Schilling Marking Svstems - SchillMark
Eile Yiew Plate Options
ETH

ERHFT S
Lopy £V aiNR u@ @
Paste SHIFT+INS
Delete ENTF

| Leftorentated .

Right orientated

Top orientated I
Bottom orientated [ 24

ewWw o

New box|

Fig. 9: "Process” menu - Aligning several boxes and intermediate saving

When selecting the Align left command, all selected boxes will be positioned flush with the left-hand
margin of the focus frame. When selecting the Align bottom command, the bottom edge of all selected
boxes will be positioned flush with the bottom edge of the focus frame, etc.

Admittedly, advanced work with a focus frame and several boxes, as described in this section,
requires some experience. However, once you have mastered this skill, your work will be all the more
efficient.

Therefore: Try, try again, it will be worth your while! And it is simpler than you think!
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5.10 Teach-In

With the Teach-In function you can move the needle above the type plate to a specific position. After
the needle has reached the wanted position you can ,tell“ the computer by pressing the OK button to
save this position as position for a tag.

To teach in the position of a tag you have to open the ,Tag“-dialogue for the concerned tag then you
have to press the Teach-In button. The , Teach-In“ dialogue appears on screen. Now you can move
the needle by pressing the concerned buttons.

Stepwidth e
4 A‘ \ v o
< 0,025 mm
= 10,50 mm Abbruch
i L 1,00 mm x -
h.00
h ‘T‘ A . o ? Hilfe
| Poszition:

Fig. 10 : Teach-In Dialog

But Attention !!! The needle moves immediately after you have pressed a concerned button. Please
avoid collisions! When the needle has reached the wanted position just press the OK button, to get to
know the computer to save this position as new position for the tag.

5.11 Changes in box type and contents

You will have noticed that in addition to position and size, the box type, the box contents and two
options may be displayed in the "Box” prompt window.

5.11.1 Box type

The following box types will be supported:

Text boxes
Date boxes
Counter boxes
Graphics boxes

In order to change the box type, the required new box type is clicked on by the mouse. Naturally, this
applies only to box types which can be converted to each other. Operations which are impossible -
depending on the present conditions - or do not make any sense will be displayed deactivated (= grey)
on the screen. Therefore you cannot go wrong!
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5.11.2 Box contents

In order to change a box contents, select the Edit box for Box contents and enter the required
contents.
The maximum length of the box contents is 120 characters.

The box contents of graphics boxes is merely of informative character.
5.11.3 Options

At present, the following options will be supported:

e Edit: This option states whether a box contents is changeable in working mode.
e Impact marking: This option states whether a box contents is to be marked.

Hint: The "Impact marking” option is very suitable for displaying close to reality pre-printed rating

plates on screen by simply including pre-printed texts of a rating plate, but suppressing marking

output by deselecting the option. Boxes which are not marked are shown as recessed boxes on
screen.

Example:

e User: 69% GDIE: 67% Schilling Marking Systems - SchillMarker 3.12

File £t ¥Yiew Plate Options
BREE | e @8] =R e

s S e

Example Foc I mm bextheighb

Example for smm

Thi= =tenicil i= mad= =rith

Schillmark=er 2.1 — Scftirars=

I]:I-=|.1:v= and time can kbe updated

lu.ut-nmat-ically..h.lsn Yvou oAarn make

Ir.tumb:r:c that increment or 4d=—

|n:'r ement mautomaticallqy.

L+l | »
| | w28y 38 | MUK |
Fig. 11: Rating plate including all available box types
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In order to enable and/or disenable options, select the appropriate control section by the mouse.
Activated options will be automatically ticked.

5.12 Changing the presentation type

In the tag-dialogue you can enter the basic settings of a tag. To the basic settings belong position and
size, tag type, tag contents, text size and text-alignment as well as options.

Furthermore you can change the presentation type, independent from the features mentioned above.

The following presentation types are distributed:
(also cap. 5.14 ,Angular tag and roundset tag" )

e Standard tag
¢ Roundset tag
e Angular tag

To change presentation type, please click with the left-hand mouse key at wanted presentation type.

Should you have selected roundset tag or angular tag, you can change the appropriate datas
(radius,angle). For this purpose please click the ,Config“ button.

If the current tag is a roundset tag the so-called ,Roundset tag” dialogue contains following datas that
can be changed now:

The Center position

Start Angle and end angle

Inward radius and outward radius

Marking direction: clockwise or counterclockwise

For ,Angular“- tags the ,Angular tag“-dialogue appears on screen after you have clicked on the
~config" button. The dialogue contains following datas that can be changed now:

o Position of the left hand top corner of the angular tag
e The angle of displaying
e Height and size of the angular tag

For standard tags the mentioned features are cancelled obviously and the ,,Config“ button is disabled.

5.13 Changes in text size and text alignment of box contents
You will have noticed that the basic features of a box may be displayed in the "Box” window. In
addition to position and size, these will also include box type, box contents and options.

Furthermore, the alignment and subsequent font size of the box contents can be manipulated within a
box irrespective of the box type.

Acknowledge the "Alignment” options. A "Box-text alignment” prompts window will be displayed.
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= Box - text alignment

horizontal alignment vertical alignment
: - Top
- %  Bottom
* Right
< Centered
 Centered
= Adapted
» Adapted ]
 Baseline
| _ | Italics | | Adapt textwidth

Textwndth: |4 38 Textheight IE_[][]

/ oK I x.ﬁ.hl:-ruch

Fig. 12: Align text prompts - Alignment and size of text within a box

5.13.1 Text width and height options

The text width and height editing boxes will display the actual size (in millimetres) of a character for
the marking output.

5.13.2 Adaptation of text width option

Should the "Adapt text width” option have been activated, the text width will be automatically adapted
to the text height. This will make specification of the text width superfluous, which will therefore be
deactivated.

5.13.3Italics option

Should you have activated the Italics option, the contents of a box will be displayed and marked in
italics, i.e. in slanted writing.

5.13.4 Horizontal and vertical alignment options

Alignment features always refer to a box, i.e. left-aligned text will always be aligned to the left-hand
margin of a box, right aligned text will always be aligned to the right-margin, etc. Otherwise alignment
of text within a box will require no special explanation.
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The difference between vertical alignment features such as "Bottom” and "Base line” lies in the fact
that the whole text within a box will be aligned to the base line for a "Base line” setting, i.e. with the
bottom section of letters such as "g”, "p”, or "y” projecting over the box.

Perhaps the alignment term "Adapted” deserves special mention. When activating one of the
alignment features such as "Horizontally adapted” or "Vertically adapted”, the box contents will be
adapted to the size of a box, i.e. text within a box is no longer left-aligned or right-aligned, but of the
same size as the surrounding box.

Hint: The "Horizontally adapted” alignment feature is excellently suited when a preset box size is
used and a text of standard width is somewhat too long for a box. When allocating the

"Horizontally adapted” alignment feature to this text, the required character width will

automatically be calculated to allow the text to accurately fit into the box, therefore filling it
completely.

The following figure shows some examples of alignment:

e User: 69% GDIE: 67% Schilling Marking Systems - SchillMarker 3.12

File £t ¥Yiew Plate Options
| e 123 | M)

ﬂ
=
E
]

""" BEL EENEE

% LEFT TOF

FEITSHT BOTTORM

CEMNTEEREED H+W

Bas=Lins

m—n —A =a F—— e == —a

L« L +

| | w63y 21 | MUK |

Fig. 13: Examples of text alignment

In principle, graphics boxes react as though "horizontally” and "vertically adapted” features had been
included.
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5.14 Other options for counter and date boxes

After having entered a counter or date box as a box type in the "Box” prompt window, the "Others”
options will be activated in addition. These options include box-specific additional settings.

5.14.1 Other settings for counter boxes

When having set a counter box as the box type in the "Box” prompt window, followed by actuating the
"Others” ooption, the "Counter box” prompt window will, for instance, display the following:

= Couting-Options

Counter Counting direction
Start II_I— Increment |1_% <+ Forward
Counter |5 | Reset counter | - Backwards
Repitition counter Leading zeros

| Attention to procesz * Motice ~» autom. reset | Uze leading
Repititions Current Pozsition cero

[100 =H [ Ssets | [ L [z 8

+| Counting alphanumerically

Prefiz |AB_1 996-
Suffix I W

V oK xAhhruch

Fig. 14: Counter box prompt - Special settings for counter boxes

Counter boxes offer the special ability of being automatically incremented and/or decremented each
time after being actuated (marking) by a set amount. When using alphanumeric counter boxes, the
actual figure may be prefixed and/or suffixed by a random text. A number having a fixed number of
digits (up to 9) and leading zeros may be displayed by actuating the "leading zeros” option.

This makes the box type very predestined for marking continuous serial or component numbers on
rating plates.

The prompt is optically divided into several function groups:

The counter group may be used for basic settings of the counter box. Counter setting represents the
actual contents of a counter box. This value is used for making the first marking after new settings.
The starting value is only important when using a repeat counter (see below), possibly resetting the
counter after reaching a set repeat number.

Counter settings may be manually reset to starting value by means of the reset counter setting
push-button.
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An increment is the value by which a counter box is incremented or decremented after each update
(each marking of a rating plate).

The counting direction group includes setting options such as forward and back for setting box
incrementations and/or decrementations.

The repeat counter is activated by enabling the Note sequence option. The box will be ticked, with
other control units in this group becoming active.

There are two options for proceeding after having achieved a set number of repeats. When selecting
the Message option, a window will be displayed with the result and offering a facility for resetting the
counter box. Autom.reset will automatically reset a counter box when a set repeat number is
reached.

The number of required repeats may be entered in the entry box of the same name or changed by the
arrow key in single steps.

The Update input box shows the present update of the repeat counter. When this counter setting is
reached, marking will be continued with the next cycle. This value may also be changed by direct input
or by means of the =>set => push-button by setting it to Repeat.

A facility for displaying a figure for a fixed width, possibly with leading zeros, is available by the Use
leading zeros option.

The required number of digits (max. 9) will be set with the input box below this. When the number of
digits is exceeded by a counter, this will be dynamically extended.

The Use alpha numeric counter box option will be activated by Prefix and Suffix prompt boxes. Any

text entered in Prefix will be a prefix to the figures of the counter box, with text entered in Suffix being
suffixed.

5.14.2 Other settings for date boxes

When having entered a date box in the "Box” prompt window as a box type, confirmed by the "Others”
control section, the "Date box” prompt window will be displayed as follows.

Dizplay
] :Hl_HFEEkdEI_',l | Calendar week v| Day | Month | Year
wWeekday Cwf M onth Year
 long “* without Cw - long “+ long
< zhort  with CW  short = ghort
< numerncal
_ | Always cument date

Day IE Month ]ﬁ

@

Fig. 15: Date prompts - Special settings for date boxes
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A special facility of the date box is automatic updating (marking) of the display (which is not
compulsory).

Furthermore, the type of date output may be very flexible. Theoretically, a total of 48 different options
is available for displaying a date. However, not all of these will be explained here. It is more important
to be familiar with the operation of the setting.

The "Display” options block will activate everything that should be displayed.

Set by the "Day of the week” "Month” and "Year” features blocks how individual components of a date
are to be displayed.

With its displayed functions, this box type is really predestined for automatically including production
and test dates of continuous series or components.

Hint: The "Date box” prompt window includes a completely functioning calendar, i.e. this prompt
window may be used in order to look up which day of the week the 12.11.1958 was, by entering
the date in the Edit box and outputting it by the Day of the week option.

5.15 Angular and roundset tags

Angular tag

This presentation type can be used to display and to mark the content of a text date or counter tag in
an angular position. Additionally to standard tags angle specific datas have to be stored. You can
create angular tags in the ,Tag" dialogue by clicking with the left-hand mouse key on ,,Angular tag“.
The geometry of the angular tag can be changed in the angular tag dialogue. Just press the ,,Config"
button and this dialogue appears on screen.

= Angular Tag Options

Poszition [Left-Top] Size

* Pozition 5.00 Width 30.00
¥ Poszition 30,00 Height .00

Angle

Angle[]  [45.00
“ 13 x.ﬁ.bl:uruch Teach In... ? Hilfe

Fig. 16: Angular Tag Options dialogue
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Now you can enter the angle specific datas:

e Position of the left hand top corner
¢ Height and width of the tag
e Angle of the tag

Fig. 17: Example for an angular tag

Roundset tag

This presentation type can be used to display and to mark the content of a text date or counter tag as
round set. Roundset tags differ from standard tags because specific datas like angle radius and so on
have to be saved. You can change the content and the dimensions of a roundset tag when you are in
the ,Tag" dialogue and you select the ,Config.” button. Then the roundset dialogue appears on screen
and you can enter roundset specific datas.

= Houndset Options

Poszition [Centerpoint]

Direction of Writing

X Position
Y Position

Angles

# Clockwizse [CW)

+ Counterclockwize [CCW)

Radiuz

Start Angle [7]
End Angle [*]

|45.I]I]
|135_I]I]

Inwardz Radius

Dutwardz Hadius

20.00

o

xﬁ.bbruch

Teach In...

? Hilfe:

ra

Fig. 18: Roundset Options dialogue : Position, angle, radius, marking direction
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The following datas are necessary to define an arc clearly:

e Position of the center

e Start angle and end angle

e Outward radius and inward radius
¢ As well as the direction of the text

o
agh

-\i@

Fig. 19: Example for a roundset tag

5.16 Saving and reading a plate

After having generated a plate, it may be written to a file. In the same way, saved rating plates may
be read from a file. Suitable commands are included in the "File” menu.

When selecting one of the following commands:

e Open file
e Save file
e Save as

A standard file prompt window will be displayed which will be familiar to you from other WINDOWS
applications:

= Datei speichern unter

Dateiname: Yerzeichnizze:
I- ]: c:hschiling

b i + = n Abbrechen

= zchiling
+
+
D ateiformat: Laufwerke:
Type Plate Filez Dateien [‘.TS[IEI I = c: reproplan |i|

Fig. 20: Save as...prompt - Saving a TSD file
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Should there be a risk of data loss, for instance when the present plate has been changed and a new
plate is to be read without having saved the changes, you will be warned as follows:

= Type plate has been changed

Save changements?

e Mein

Fig. 21: Warning when changes have not been saved

The same warning will be displayed when you are about to leave the programme without previously
saving your changes.

5.17 Marking a rating plate

After having generated a plate, you will surely want to mark it repeatedly.

In order to be able to mark a plate, data describing the image of the plate must be transmitted to the
controller of the Impact Marker. The controller is in a position to save data for one sign in its own
memory.

After having transmitted data of a plate to the controller once, the plate (and only this one) may be
marked as often as you wish without having to transmit new data to the controller, even when the
controller is switched off in between. This will, however, also mean that when a series of rating plates
having continuous numbers is to be marked, the data of the plates must be retransmitted to the
controller of the Impact Marker after each marking cycle.
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The features of the controller described and the functionality of the SchillMarker are also reflected in
the commands of the "File” menu, which will be displayed as follows:

bl User: 69% GDI: 67% Schilling Marking Syd
Edit VYiew Plate Options

e = 2 ]
Save
Save as... L : o

Print
Configure printer

Transmit
Start marking
Update

el |

Exit
|

Fig. 22: Automark file menu

5.17.1 Transmitting plate data

This command is exclusively used for transmitting the data of a rating plate to the controller of the
Impact Marker.

5.17.2 Start marking

This command is used exclusively for marking a rating plate saved in the memory of the Impact
Marker’s controller.

5.17.3 Updating

This command is used exclusively for updating the present rating plate by the SchillMarker software.
When updating, counter boxes are incremented, with the present date being reset.

5.17.4 Automark

This command is a summary of the three steps: Update, transmit, start marking. This command will
therefore only be used when a series of rating plates having continuous numbers is to be marked.
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5.18 Configuration

Commands used for configuration of the software are included in the "Options” menu.

Working mode

COM - port
YWorking area

=

43

Marking quality
Botation of marking output about 90°

Fig. 23: Options menu

5.18.1 Changeover between design and working mode

As described above, the SchillMarker may be operated in two different modes. Changeover between
design and working mode is based on the "Options” menu, with the active mode being ticked on the
menu.

5.18.2 Serial interface (COM port)

Owing to a PC only having 4 serial interfaces, the SchillMarker allows setting of the interface used.
Other serial transmission parameters, such as Baud rate, word length or parity checks are defaults set
by the controller of the Impact Marker and therefore do not require setting by the user of the
SchillMarker.

In order to change the COM port (= interface) for data transmission, select the "COM-Port” command
in the "Options” menu. The "COM-Port” prompts window will be opened and displayed as follows:

= COM-Fort

COM 1 © COM 3
> COM 2 < COM 4

xﬁ.bbruch

Fig. 24: Prompts for selection of the COM port used
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5.18.3 Marking quality

Impact marking quality includes all settings affecting the impact marking results, which are as follows:

e Travel speed of the marking needle
e Needle frequency (= density of impact marking points)
e Pulse duration of pressurisation (= impact marking depth)

The travel speed is the speed at which the impact marking needle is moved during marking. Due to
the fact that the marking needle is operated at a set needle frequency, the travel speed, together with
the needle frequency, is important for the density of marking points and therefore of great importance
to the image of the marking.

Pulse duration is a measure of the energy by which the marking needle impacts the workpiece and
therefore a measure of the impact marking depth of a specific material.

In order to change the impact marking quality, select "Marking quality” form the "Options” menu. This
will open the "Marking quality” prompts window which will be displayed as follows:

= Marking quality

Marking speed Meedel frequency Pulze duration
[1.. 200 mm{z] [10 .. 100 Hz] [2 .. 9.5 mz]
= 20 mmis 120 mm/s » 50 [Hz]
C 40mmfs 160 mm/s © 75[Hz] [5.0 ms
<+ 80 mmts 200 mmfs < 100 [Hz]
L« L1 [+] «l IIEY « [ 3]
80 mm/{s 100 Hz 50 ms
Dotz per mm: 1.250 / mm
Diztance between two dots: 0.800 mm
x.ﬁ.hhruch

Fig. 25: Marking quality prompts - Travel speed, needle frequency and pulse duration

You may now enter the settings for the marking quality as follows:
1.) In steps by setting a suitable value
or

2.) infinitely variable by setting the slide ruler.
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5.18.4 Rotation of marking output by 90°

This option allows clockwise rotation of the full marking output by 90°.

Important:  This is a system setting which means that this option is not saved in the rating plate file
(*.TSD) and will possibly have to be set again after loading the file. This option may be
accessed by the OPTIONS menu ROTATE PLOT BY 90°. When this option is
activated, this item of the menu is ticked. Should a rating plate, which has not been
rotated, have to be output after outputting a rating plate, rotated by 90°, this Option
must be deactivated manually. Should this option have been activated when exiting
the SchillMarker software, it must be activated after a new start and be deactivated
manually, if required, prior to outputting a rating plate which is not rotated.
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5.19 Practical suggestions on adjusting the parameters

The microdot Marking Unit provides high flexibility in order to match the various marking needs

by means the adjustment of different parameters:
e Stylus stroke frequency (from 10 to 100 Hz)
e Stylus stroke pulse length (from 2.5 to 9.5 ms)
e Stylus movement speed (from 1 to 200 mm/sec)
e Air pressure (max 6 Bar)
e Type of the stylus

e Stylus-to-plate distance.

Depending the various combinations of these factors, very different marking results may be

obtained.

In any case a compromise between marking speed and quality must be reached as both act in

antithesis.
We remember that, over some limits, the marking deep and the speed are in antithesis too.
Therefore, when you have a piece to be marked the first question is:

Which factor to privilege; working speed, marking quality, marking deep, or
the noise level?

1. If Speed is prevailing, we suggest:

Frequency 100 Hz, Pulse length 5 ms, Speed from 10 to 50 mm/sec in relation to the
quality result you need (more is the speed more are the dot distance, and worse is the

guality), movement speed with stylus up: 100mm/s.

2. If Quality is prevailing, we suggest:

Frequency 100 Hz, Pulse length 5 ms, Speed from 10 to 50 mm/sec in relation to the

character high (smaller the character and less must be the speed).

3. If Deep is prevailing, we suggest:

Frequency 50 Hz, Pulse length 9.5 ms, Speed 10 mm/sec using the heavy sintered stylus
(option). Remember that this stylus can not be used for soft material, as plastic or

aluminum.

4. If low noise is prevailing, we suggest:

Frequency from 10 to 25 Hz, Pulse length 9.5 ms, Speed value according the previous

criteria (in this case the dots are spaced and the result seems as a dot matrix).

Besides, we remember the following general rules:

. The heavy sintered stylus 92 HRC is used for hard material and/or deeper marking. In

other cases the lighter stylus can be used.

. More the distance between the stylus tip and the marking surface and more is the stroke

power (adjust the distance between 0 and 5 mm max.).

. In case of pressure leakage in consequence of the distance between marking unit and
compressor, or when you have to mark very soft material (plastic, aluminum, etc.) at high
marking speed (>20 mm/sec), we suggest to reduce lightly the Pulse length of 0.5 - 1 ms.
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. More the speed and more the stroke power under the same pressure value. May be
useful to increase the air pressure as the speed increases.

SUGGESTIONS FOR SELECTING THE AIR PRESSURE AND THE STYLUS-PIECE DISTANCE

As the Frequency, Pulse length, Speed and Stylus type have been selected according the
previous criteria, it is necessary to set the air pressure and the stylus distance.

Proceed as follows:

1. As the text or drawing to be marked has been programmed and the piece positioned and
fastened, execute a free cycle (with pressure at zero) pushing on the Start button in order
to verify the correct path of the stylus.

2. Then, depending by the stylus used:

A. With light stylus and remote 1/O provided with pressure regulator:

position the stylus at 1 mm from the piece
set the pressure value at 6 Bar
set the 1/O pressure regulator at 00 value

push on the Start button and increase gradually the pressure by means of the I/O
regulator up to reach the correct vibration of the stylus with a regular noise and a
good marking result.

If the marking deep is too high, reduce the piece-stylus distance and, keeping
unchanged the other parameters, repeat the test. Try many times reducing the
distance up to reach the quality desired.

If the marking deep is too light although the max pressure has been reached with the
I/0 regulator at 99, it necessary to increase gradually the piece-stylus distance. Try
many times up to reach a good result. If the marking deep is still light, use the heavy
sintered stylus.

B. With sintered stylus and remote I/O provided with the pressure regulator:

Note:

set the 1/O regulator at 99

set pressure to zero by closing the regulator on the marking head
position the stylus at distance of about 2 mm

verify the fastening of the piece

push on the Start button and increase gradually the pressure by adjusting the
marking head regulator up to reach a good result

increase or decrease the distance in order to increase or decrease the marking
deep.

Do not wait for the cycle end for changing the parameters; stop the cycle pushing on
the proper 1/O button
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Needle freq. Transversal speed Dots/mm Dist. between dots
(Hz) (mm/sec) (N°) (mm)
50 1 50 0.02
5 10 0.1
10 5 0.2
20 2.5 04
30 1.66 0.6
40 1.25 0.8
50 1 1
60 0.83 1.2
70 0.73 1.4
80 0.65 14
90 0.55 1.8
100 0.50 2
150 0.33 3
200 0.25 4
75 1 75 0.01
5 15 0.06
10 7.5 0.13
20 3.75 0.26
30 25 0.4
40 1.87 0.53
50 15 0.66
60 1.25 0.8
70 1.07 0.93
80 0.93 1.06
90 0.83 1.2
100 0.75 1.33
150 0.5 2
200 0.37 2.66

The following tables give the correspondences between needle frequency/transversal
speed/dots per mm and distance between dots.
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Needle freq. Transversal speed Dots/mm Dist. between dots
(Hz) (mm/sec) (N°) (mm)
100 1 100 0.01
5 20 0.05
10 10 0.1
20 5 0.2
30 3.33 0.3
40 25 0.4
50 2 0.5
60 1.66 0.6
70 1.42 0.7
80 1.25 0.8
90 1.11 0.9
100 1 1
150 0.66 15
200 0.5 2

Qk\\HC,<|/>O
—g Schilling Marking Systems GmbH Jor) i ) i % www.schilling-marking.de & z
‘-‘ In Gruben&cker 1 DE-78532 Tuttlingen +49 (0)7461 9472:0 = +49 (0)7461 9472-20 YN info@schilling-marking.de ’gl/ng;a X

1509



S Wy elyiilins)

Marking Systems GmbH

S

MK3 - User’s Manual
Practical suggestions

58

Speed Needle freqg. Dots/mm Dist. between dots

(mm/sec) (Hz) (N°) (mm)
1 50 50 0.02
75 75 0.133

100 100 0.01

5 50 10 0.1
75 15 0.06

100 20 0.05

10 50 5 0.2
75 7.5 0.13

100 10 0.1

15 50 3.33 0.3

75 5 0.2

100 6.66 0.15

20 50 25 0.4
75 3.75 0.26

100 5 0.2

30 50 1.66 0.6

75 25 0.4

100 3.33 0.3

40 50 1.25 0.8
75 1.87 0.53

100 25 0.4

50 50 1 1

75 15 0.66

100 2 0.5

60 50 0.83 1.2

75 1.25 0.8

100 1.66 0.6

70 50 0.75 1.33
75 1.07 0.93

100 1.42 0.7
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Speed Needle freq. Dots/mm Dist. between dots
(mm/sec) (Hz) (N°) (mm)

80 50 0.62 1.6
75 0.93 1.07
100 1.25 0.8

90 50 0.55 1.82
75 0.83 1.2
100 111 0.9

100 50 0.5 2
75 0.75 1.33
100 1

150 50 0.33
75 0.5 2
100 0.66 15

200 50 0.25 4
75 0.37 2.66
100 0.5 2
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6. MAINTENANCE

6.1 Introduction
The inspection consist of standard maintenance that can be done directly by the user, and of
preventive and/or corrective interventions that can be carried out only by the Technical Service.
As all the electric and mechanic appliances, this unit needs not only a correct use but also the

maintenance and inspections at regular intervals. This care will grant a continuous and efficient
operation of the marking system.

6.2 Standard Maintenance

This maintenance must be carried out periodically every 6 months assuming an use of 8 hours
per day of the stamper.
Lubricating the movements bars
Remove the protection carter.
Remove the dust in the interior of the equipment.
Dampen a not abrasive cloth with vaseline oil (type for sewing-machine) and clean
accurately the shafts.
Pneumatic Group
Dismount the air filter.
Blow in by means of an air gun (max 6 atm.) in opposite direction of the normal
operation.
Verifying and adjusting the belt tension

Apply a load of 150 gr. on the middle point of the belts between the pulleys and verify
that the flexion is less of 5 mm.

If not, adjust on both tensioning pulleys.

Electrovalve
Verify that the electrovalve silencer is not obstructed by dust.

To access , unscrew the silencer and blow in by means of an air gun (max 6 atm.) in
opposite direction of the discharge.
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6.3 Troubleshooting

a) In case of no operation of the system, verify:
The voltage on the power socket.
The external connections.

The internal fuses of the Controller; these fuses are accessed by removing the external
carter of the unit.

If one or more fuses are blown, replace with same value and type.

If the fault continues, call the Service Assistance.

b) In case of operation anomaly

The Controller is provided with diagnostic and status circuits. The results are reported by
LEDs on the front in order to display immediately the operating status and to find a
possible fault.

The figure shows the front view of the controller. The meaning of the LEDs is reported on
the next page.
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FRONT VIEW OF THE CONTROLLER
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6.4 MEANING OF THE LED
TYPE MEANING NOTES
+35 MOTOR ELECTROVALVE POWER +35 Volt
+24 1/0 AUXILIARY CIRCUIT POWER +24 Volt
+12 ELECTROVALVE SERVICE POWER +12 Volt
+5P MOTOR LOGIC POWER +5 Volt
+5L CONTROLLER POWER +5 Volt
EV ELECTROVALVE ON on for EV enabled
ST INPUT OF MARKING START on for START enabled
SP INPUT OF MARKING STOP on for STOP enabled
RD CONTROLLER OK on for Controller OK
FM MARKING END off during the marking
PU STYLUS COMMAND on for stylus enabled
MP PRESSURE MIN. on for min. pressure switch closed
IM MOTOR RESOLUTION 1-% step
EN MOTOR ENABLE on for motors free
CX CLOCK MOTOR X on at each step of the motor movement X
CY CLOCK MOTOR Y on at each step of the motor movement Y
cz CLOCK MOTORCOR Z on at each step of the motor movement C or Z
I' ATTENTION ! If in the SM-Program C- or Z-axis is akivated, the Y-axis is deactivated
DX DIRECTION MOTOR X off for motor to direction X zero mechanic
DY DIRECTION MOTOR Y on for motor to direction Y zero mechanic
Dz DIRECTION MOTOR COR Z on for motor to direction C or Z zero mechanic
FX END TRAVEL AXIS X on for end travel X on zero mechanic
FY END TRAVEL AXIS Y on for end travel Y on zero mechanic
Fz END TRAVEL AXISCOR Z on for end travel C or Z on zero mechanic
www.schilling-marking.de &®\;w04,/oz
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7. TECHNICAL SPECIFICATION

Marking area (X/Y) 50 x 80 - 100 x 80 mm or 200 x 200 mm

Marking height (X) (Y) 275 mm

(with optional standard column frame)

Stylus traverse speed 1to 200 mm/s

Marking resolution 0.025 mm (on both X/Y axis)

Character height 0.1 to 100 mm (increment of 0.025 mm)

Stylus frequency max 100 Hz

Marking head orientation no limits

Marking head weight 12.5 kg (100x80 )

5 kg (80x50)
15 kg ( 200x200 )

Air requirements max 300 I/min.

Working pressure max 6 bar

Marking force 500 kg ( 100x80 and 200x200 )

Stylus travel max 10 mm (£ 5 mm)

Stopping device for minimum input from external pressure switch

Noise level (idling) max 67 dB

Supply voltage 115/230 Vac + 20%, 50/60 Hz

Power requirements 200 VA

Diagnostic system 20 LEDs

Memory capacity 200 KB

Memory expansion (optional) 200 KB

Back-up battery lithium battery

PC interface RS 232

Protocol communication HP-GL 7585B compatible

Control Unit dimension 310x100x200 mm

Control Unit weight 4.5 kg

Column frame (optional) weight 15 kg

Clipping function yes
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7.1 Eprom exchange
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QL\\HC,<|/>O
Schilling Marking Systems GmbH Jor) i ) i % www.schilling-marking.de & z
In Grubenécker 1 DE-78532 Tuttingen +49 (0)7461 94720 [ +49 (0)7461 947220 X L2 K

info@schilling-marking.de %S
1509



E Jd Hﬁm, MK3 - User's Manual 65

Marking Systems GmbH Software Licence Agreement

8.

SOFTWARE LICENCE AGREEMENT

With the purchase of the Software you automatically agree in the conditions of Software Licence
Agreement!

The subject matter of this Agreement shall be the copyright and the scope of use of computer SOFTWARE recorded on data
carriers (CD-Rom), the description of the program, the operating instructions and any other written material connected with the
same.

Schilling Marking Systems alerts to the fact that according to the state of technology it is impossible to generate computer software
to work without fault in any application and combination. The subject matter of this Agreement shall therefore include SOFTWARE
only which is applicable in principle according to the program description and the operating instructions.

The Licencee shall be responsible for the suitability for integration of any SOFTWARE supplied into other applications and
combinations. Any setting-up and programming costs shall be paid by the Licencee. These costs shall be separately invoiced.

For the term of this Agreement, Schilling Marking Systems agrees to grant to the Licencee a simple, non-exclusive and personal
LICENCE for the use of the attached copy of Schilling Marking Systems SOFTWARE on one machine/computer only (i.e. only
referring to one single central processing unit (CPU) and in one location only). Should this single machine/computer be a multi-user
system, this right of use shall apply to all users of such a system.

Licencees shall be allowed to transfer the SOFTWARE physically (i.e. stored on a data carrier) from one computer/machine to
another computer/machine, provided that only one single computer/machine is used at any given point in time. Any additional use
shall not be permitted.

The Licencee agrees to desist from the following:

a) to transfer the SOFTWARE or any written material connected with the same to any third party or to make the same accessible to
any third party without he prior written permission by Schilling Marking Systems.

b) to transmit the SOFTWARE from a computer/machine through a network or a data communications channel to any other
computer/machine.

c) to modify, translate, retro-develop, decompile or deassemble the SOFTWARE without the prior written permission of Schilling
Marking Systems.

d) compile any works derived from the SOFTWARE or to duplicate any written material, to translate, modify or compile works
derived from any written material.

With the purchase of the product, the Licencee shall only acquire property rights in the data carrier as such on which the
SOFTWARE is recorded, but no rights in the SOFTWARE as such. Any publication, duplication, processing and utilisation rights in
the SOFTWARE shall remain the exclusive property of Schilling Marking Systems.

The SOFTWARE and any written material connected therewith shall be subject to copyright. Should the SOFTWARE not be write
protected, the production of one single back-up copy shall be allowed to the Licencee. The Licencee agrees to include on such
back-up copy a reference to the copyright of Schilling Marking Systems or to incorporate it in the same.

Any reference to a copyright incorporated in a back-up copy and any registered numbers included in the same shall not be
removed. It is expressly forbidden to fully or partially copy or otherwise duplicate the SOFTWARE and any written material in its
original or modified form or in any form whatsoever mixed with other software or incorporated in any other software.

Any right to use the SOFTWARE shall only be transferred to third parties subject to the prior written agreement by Schilling Marking
Systems and in compliance with the provisions of this Agreement only. Transfer of the SOFTWARE by way of a gift, rental or leasing
shall be expressly forbidden.

This Agreement shall have an unlimited term. The Licencee’s right to use the SOFTWARE shall expire automatically without notice
should any provision of this Agreement be infringed. On termination of the usufructuary right, the Licencee agrees to destroy the
original disk and any copies of the SOFTWARE including any modified copies and any written material.

Schilling Marking Systems points out that the Licencee shall be liable for any loss based on copyright infringement caused to
Schilling Marking Systems by an infringement of the conditions of this Agreement on the part of the Licencee.

Schilling Marking Systems shall be entitled to provide updates of the SOFTWARE at their sole discretion. Schilling Marking
Systems shall not be held to make available any updates of their SOFTWARE to licencees not having returned a signed copy of
their SOFTWARE Licence Agreement to Schilling Marking Systems.

a) Schilling Marking Systems guarantees to the original Licencee that at the time of transfer any data carriers on which the
SOFTWARE is recorded and any hardware supplied together with the SOFTWARE is free from faulty materials when used subject
to normal operating conditions and maintenance.

b) Should the SOFTWARE or any data carrier supplied with the same be faulty, the recipient may demand a replacement during a
period of warranty of one month after delivery. In this case the disk, any back-up copy and the written material, accompanied by one
copy of the invoice/receipt shall be returned to Schilling Marking Systems.

¢) Schilling Marking Systems shall not be responsible for any reasons stated in para. 1 above for the SOFTWARE being faultless.
In particular, Schilling Marking Systems shall not guarantee the SOFTWARE meeting the requirements and being suitable for the
purposes of the purchaser or in combination with other selected software. The purchaser shall be responsible for the correct
selection and any consequences due to the application of the SOFTWARE and any intended or achieved results. The same shall
apply to any written material accompanying the SOFTWARE.

d) Schilling Marking Systems shall not be liable for any losses or losses caused intentionally or by gross negligence on the part of
Schilling Marking Systems. In a business context, any liability for gross negligence shall furthermore be excluded. Liability for any
characteristics assured by Schilling Marking Systems shall be unaffected by the above. Any liability for consequential damages not
included in an express assurance shall be null and void. Should you have any queries regarding this SOFTWARE Licence
Agreement or want to contact Schilling Marking Systems, please write to:

Schilling Marking Systems GmbH, In Grubenaecker 1, DE-78532 Tuttlingen, Germany, Telephone.: +49 (0)7461 9472-0, Facsimile:
+49 (0)7461 9472-20, eMail: info@Schilling-Marking.com, www.Schilling-Marking.com
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To
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Marking Systems GmbH
In Grubenaecker 1
DE-78532 Tuttlingen

Germany

ANSWER CARD referring to the Licence Agreement:

Serial No. of SOFTWARE: (see CD)

| agree to the conditions of the SOFTWARE Licence Agreement in hand.

Place and Date: Signature:

Company stamp
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